物联管理平台终端设备接入流程及规范
1、 提交物联接入\取数申请单
[bookmark: _GoBack]物联接入申请单 ：（信息内网：物联开放服务平台（平台地址：http://25.214.201.251）》个人工作台》工单系统》接入\取数申请）
接入申请单示例：
	国网四川省电力公司智慧物联场景接入申请表
编号:2*****	 申请日期:2022-11-15
	场景概述
	场景名称
	信息机房智慧物联

	
	申请人门户
	PanJC5145

	
	所属单位
	国网四川阿坝州电力有限责任公司（国网四川省电力公司阿坝供电公司）

	
	联系人
	****
	联系电话
	*****

	
	专业
	信息
	集成厂商
	****

	
	厂商联系人
	****
	生产设备
	上传设备安全检测报告

	
	信息化职能部门
	数据应用班

	
	场景类别及概述
	实时采集监控机房内环控环境数据，如配电、温湿度、空调等，并可实现远程查看和操作将数据接入省公司物联网平台，在省物联平台可查看机房物理环境，实现数据集中管理、集中监控。

	
	场景接入方案
	设备接入详情：
（1）前端采集数据设备：温湿度监测（16个）；精密空调控制器（3台）；UPS（2台）；直流通信电源（2套）；配电柜（3套）；电量仪（6套）；漏水检测（2套）；气体检测（1套）。
接入组网方式及技术参数如下：
[image: Generated]

	申请部门(单位)
	　
　

	本单位信息化职能管理部门（单位）意见
	





2、 网络连接方式
防火墙网络（根据实际设备接入情况需求选择防火墙网络为目的ip地址和端口）：
2.1、物联内网
防火墙： 
	目的ip地址
	目的端口

	25.214.208.191
	21883


2.2、物联专网：
省侧安全网关的防火墙（安全网关地址）：
	目的ip地址
	目的端口

	99.0.34.90
	20090


在mas工单上申请数字证书
3、 物联平台创建台账
3.1、物联开放服务平台操作文档
	物联开放服务平台操作手册
平台地址：物联开放服务平台：http://25.214.201.251
一：创建产品
1、创建网关产品
[image: 图形用户界面, 应用程序

描述已自动生成]
2、创建普通产品
[image: 图形用户界面, 应用程序

描述已自动生成]
3、字段说明
	字段
	必选/可选
	类型
	描述
	名称规范

	组织机构
	必选
	下拉框
	选择设备所属单位
	如下拉选项没有联系物联平台人员添加

	所属专业
	可选
	下拉框
	选择设备对应专业
	如下拉选项没有联系物联平台人员添加

	产品名称
	必选
	String
	由用户自定义产品的名称
	命名规范参考对应接入规范文档

	产品型号
	必选
	String
	由用户自定义产品型号
	命名规范参考对应接入规范文档

	厂商名称
	必选
	下拉框
	下拉选择该产品对应的厂商
	如下拉选项没有联系物联平台人员添加

	节点类型
	必选
	下拉框
	下拉选择该产品对应的节点
	创建网关产品选择边缘设备
创建普通产品选择终端设备

	设备类型
	必选
	下拉框
	选择产品对应的类型
	如网关产品选择边缘物联代理,温湿度普通产品选择温湿度

	边缘计算框架
	必选
	下拉框
	选择产品对应的计算框架
	

	区域名称
	必选
	下拉框
	选择产品对应的区域
	

	产品描述
	可选
	String
	对该产品的描述
	



二、创建设备
1、创建网关设备
[image: ]
2、创建普通设备（直连设备）
[image: 图形用户界面, 应用程序

描述已自动生成]
3、创建网关子设备
一般由开发人员通过mqtt协议程序创建，设备名称、标识等参考对应接入规范文档；mqtt规范参考物联管理平台接入协议规范。
4、字段说明
	字段
	必选/可选
	类型
	描述
	名称规范

	选择产品
	必选
	下拉框
	选择设备所对应类型的产品
	创建网关设备选择所创建的网关产品；创建普通设备选择所创建的普通产品

	所属单位
	必选
	下拉框
	选择设备所属单位
	如下拉选项没有联系物联平台人员添加

	设备名称
	必选
	String
	由用户自定义设备的名称
	命名规范参考对应接入规范文档

	设备标识
	必选
	String
	由用户自定义设备标识
	命名规范参考对应接入规范文档

	所属位置
	必选
	String
	选择所属单位后自动生成
	

	是否明文
	必选
	下拉框
	下拉选择该设备是否明文
	

	所属专业
	必选
	下拉框
	选择设备对应的专业
	

	操作系统类型
	必选
	下拉框
	选择设备对应的操作系统类型
	

	所属分组
	可选
	String
	选择设备对应的分组
	一般不填写

	关联北向应用
	可选
	String
	设备所关联的应用
	一般不填写

	设备描述
	必选
	String
	对该设备的描述
	






3.2、统一物联门户操作文档
	统一物联门户操作文档

Portal地址：http://iot.scdl.cn:18080
一、创建物模型（原roma产品）
说明：创建产品在物模型的导航栏里选择所要创建的对应设备类型，若该类型已创建有产品信息则参考步骤3：克隆产品 进行产品创建。若物模型里没有要创建的设备类型，可去设备类型里创建或者联系物联平台管理人员创建。
1、创建边缘设备(原Roma网关产品)
[image: 图形用户界面, 文本, 应用程序

描述已自动生成]
2、创建终端设备(原Roma普通产品)
[image: ]

3、克隆产品
[image: ]

4、查看产品信息：
备注：可在图中圈红地方切换产品进而查看自己所创建的产品
[image: ]
5、字段说明
	字段
	必选/可选
	类型
	描述
	名称规范

	设备模型名称
	必选
	String
	自定义创建的产品名称
	参考对应规范文档

	设备模型型号
	必选
	String
	填写实际使用的产品型号，由用户自定义
	参考对应规范文档

	模型版本
	必选
	String
	根据系统自动获取
	

	节点类型
	必选
	选择
	选择边缘设备则创建网关产品       选择直连设备则创建普通产品
	

	接入协议
	必选
	下拉框
	下拉根据实际选择该产品接入的协议
	

	所属专业
	必选
	下拉框
	下拉选择该产品对应的专业，数据来源于数据字典，可联系物联平台管理人员添加
	

	厂商名称
	必选
	下拉框
	下拉选择该产品对应的厂商，填写产品的实际厂商名字，若下拉框中没有联系物联平台管理人员添加
	

	厂商ID
	必选
	String
	选择厂商名称后自动填充
	

	模型描述
	可选
	String
	自定义对该产品的描述
	


二、创建设备档案（原roma设备）
说明：选择边缘设备(网关产品)创建网关设备；选择直连设备(普通产品)，创建普通设备；网关子设备一般由开发人员通过mqtt协议创建。
1、创建网关设备
[image: ]
2、创建普通设备：
[image: ]
3、查看设备信息：
[image: ]
4、字段说明
	字段
	必选/可选
	类型
	描述
	名称规范

	节点类型
	必选
	选择框
	选择边缘设备创建网关设备，选择直连设备创建普通设备
	

	物模型
	必选
	下拉框
	下拉选择该设备对应的产品，新创建的设备将继承该产品定义好的功能和特性
	

	设备标识
	必选
	String
	设备的唯一标识，根据实际情况自定义
	参考相关接入规范文档

	功能位置编码
	可选
	String
	根据实际情况选择填写
	

	功能位置名称
	可选
	String
	根据实际情况选择填写
	

	设备名称
	必选
	String
	根据实际情况自定义
	参考相关规范文档

	上级设备物联标识
	可选
	String
	根据实际情况自定义选择填写
	

	子设备物联标识
	可选
	String
	根据实际情况自定义选择填写
	

	确认密码
	可选
	String
	用户自定义
	

	描述
	可选
	String
	自定义对该设备的描述
	

	所属单位
	必选
	下拉框
	下拉选择该设备对应的管理单位
	

	所属位置
	必选
	下拉框
	下拉选择该设备对应的单位所在位置，若没有位置可联系物联平台管理人员添加
	

	所属区域
	必选
	下拉框
	选择所属单位和位置后自动填充
	

	操作系统类型
	必选
	下拉框
	下拉选择该设备对应的操作系统类型，数据来源于数据字典
	具体操作可参考下方六：字典管理


三、消息主题
1、创建消息主题
[image: ]
2、字段说明：
	字段
	必选/可选
	类型
	描述

	消息主题名称
	必选
	String
	用户自定义

	消息主题描述
	可选
	String
	自定义对该主题的描述


四、发布订阅主题：
[image: 图形用户界面, 表格

描述已自动生成]
五、传输通道（原roma规则引擎）
1、创建规则引擎
[image: 图形用户界面, 应用程序

描述已自动生成]
	字段
	必选/可选
	类型
	描述

	传输通道名称
	必选
	String
	用户根据规范自定义规则引擎名称

	描述
	可选
	String
	自定义对该规则的描述


2、配置规则引擎：
在规则引擎的配置规则中进行数据源端和目标段的操作
[image: 社交网络的手机截图

描述已自动生成]



4、 物联管理平台接入协议规范
	一、MQTT协议通信规范
1网关登录
平台南向支持MQTT协议的connect消息接口，获取鉴权信息“clientId”、“Username”、“Password”。此三个参数在物联平台创建网关设备时获取，可自定义。
参数说明
	参数
	必选/可选
	类型
	参数描述

	clientId
	必选
	String(256)
	一机一密的设备clientId由4个部分组成：deviceId/nodeId、鉴权类型、密码签名类型、时间戳，通过下划线“_”分隔。
· 鉴权类型：长度1字节，当前支持2个类型：
· “0”，表示使用一机一密设备的deviceId接入。
· “2”，表示使用一机一密设备的nodeId接入。
· 密码签名类型：长度1字节，当前支持2种类型。
· “0”代表HMACSHA256不校验时间戳。
· “1”代表HMACSHA256校验时间戳。
· 时间戳：为设备连接平台时的UTC时间，格式为YYYYMMDDHH，如UTC 时间2018/7/24 17:56:20，则应表示为2018072417。
以deviceId为例的clientId示例为：D39564861q3gDa_0_0_2018072417

	Username
	必选
	String(256)
	一机一密的设备“Username”。
· 使用deviceId接入时填写为设备注册成功后返回的“deviceId”值。
· 使用nodeId接入时填写为设备注册成功时的“nodeId”值。

	Password
	必选
	String(256)
	Password的值为使用“HMACSHA256”算法以时间戳为秘钥，对secret进行加密后的值。
secret为注册设备时平台返回的secret，或者是设备自身的secret。


2添加网关子设备
网关设备登录后可通过此topic创建网关子设备，其中gatewayId为网关设备的设备标识（创建网关设备时自定义）
主题Topic
	Topic
	/v1/devices/{gatewayId}/topo/add

	消息发送方
	边设备

	消息接收方
	物联网平台


参数说明
	字段名
	必选/可选
	类型
	参数描述

	mid
	必选
	Integer
	命令ID。

	deviceInfos
	必选
	List<DeviceInfos>
	子设备信息列表，列表大小1~100。


DeviceInfos结构体说明
	字段名
	必选/可选
	类型
	参数描述

	nodeId
	必选
	String
	设备标识。
支持英文大小写，数字和中划线，长度2-64。

	name
	可选
	String
	设备名称。
支持中英文大小写，数字，中划线和#，长度2-64。

	description
	可选
	String
	设备描述。
描述长度不能超过200。

	manufacturerId
	必选
	String
	厂商ID。
支持英文大小写，数字，中划线和下划线，长度2-50。

	model
	必选
	String
	产品型号。
支持英文大小写，数字，中划线和下划线，长度2-50。


示例
	{
       "deviceInfos": [{
              "manufacturerId": "Test_n",
              "model": "A_n",
              "nodeId": "n-device"
       }],
       "mid": 7
}




3添加网关子设备响应
主题Topic
	Topic
	/v1/devices/{gatewayId}/topo/addResponse

	消息发送方
	物联网平台

	消息接收方
	边设备


参数说明
子设备添加成功后会返回响应，其中包含新增的子设备信息，二次开发需自行在本地保存新增的子设备信息，其中返回的deviceId字段将用于子设备数据上报、设备状态更新和子设备删除。
响应参数说明
	字段名
	必选/可选
	类型
	参数描述

	mid
	必选
	Integer
	命令ID。

	statusCode
	必选
	Integer
	请求处理的结果码。
“0”表示成功。
非“0”表示失败。

	statusDesc
	可选
	String
	响应状态描述。

	data
	必选
	List< AddDeviceRsp >
	添加子设备的结果信息。


AddDeviceRsp结构体说明
	字段名
	必选/可选
	类型
	参数描述

	statusCode
	必选
	Integer
	请求处理的结果码。
“0”表示成功。
非“0”表示失败。

	statusDesc
	可选
	String
	响应状态描述。

	deviceInfo
	可选
	DeviceInfo
	设备信息。


DeviceInfo结构体说明
	字段名
	必选/可选
	类型
	参数描述

	nodeId
	必选
	String
	设备标识。
支持英文大小写，数字和中划线，长度2-64。

	deviceId
	必选
	String
	平台生成的设备唯一标识，对应设备客户端ID。

	name
	必选
	String
	设备名称。
支持中英文大小写，数字，中划线和#，长度2-64。

	description
	可选
	String
	设备描述。
描述长度不能超过200。

	manufacturerId
	必选
	String
	厂商ID。
支持英文大小写，数字，中划线和下划线，长度2-50。

	model
	必选
	String
	产品型号。
支持英文大小写，数字，中划线和下划线，长度2-50。


示例
	{
       "data": [{
              "deviceInfo": {
                     "manufacturerId": "Test_n",
                     "name": "n-device",
                     "model": "A_n",
                     "nodeId": "n-device",
                     "deviceId": "D59eGSxy"
              },
              "statusCode": 0
       }],
       "mid": 7,
       "statusCode": 0
}




4更新网关子设备状态
主题Topic
	Topic
	/v1/devices/{gatewayId}/topo/update

	消息发送方
	边设备

	消息接收方
	物联网平台


参数说明
	字段名
	必选/可选
	类型
	参数描述

	mid
	必选
	Integer
	命令ID。

	deviceStatuses
	必选
	List<DeviceStatus>
	设备状态列表，列表大小1~100。


deviceStatus
	字段名
	必选/可选
	类型
	参数描述

	deviceId
	必选
	String
	平台生成的设备唯一标识，对应设备客户端ID。

	status
	必选
	String
	子设备状态：
OFFLINE：设备离线
ONLINE： 设备上线


示例
	{
       "deviceStatuses": [{
              "deviceId": "D59eGSxy",
              "status": "ONLINE"
       }],
       "mid": 9
}




5删除网关子设备
主题Topic
	Topic
	/v1/devices/{gatewayId}/topo/delete

	消息发送方
	物联网平台

	消息接收方
	边设备


参数说明
	字段名
	必选/可选
	类型
	参数描述

	id
	必选
	Integer
	删除子设备命令ID。

	deviceId
	必选
	String
	平台生成的设备唯一标识，对应设备客户端ID。

	requestTime
	必选
	Timestamp
	请求时间戳。

	request
	必选
	JsonObject
	子设备信息。


JsonObject结构体说明
	字段名
	必选/可选
	类型
	参数描述

	manufacturerName
	必选
	String
	厂商名称。
支持长度2-64。

	manufacturerId
	必选
	String
	厂商ID。
支持英文大小写，数字，中划线和下划线，长度2-50。

	model
	必选
	String
	产品型号。
支持英文大小写，数字，中划线和下划线，长度2-50。


示例
	{
       "requestTime": 1576639584536,
       "request": {
              "manufacturerName": "ATest_n",
              "manufacturerId": "Test_n",
              "model": "A_n"
       },
       "id": 8,
       "deviceId": "n-device"
}




6查询网关信息
主题Topic
	Topic
	/v1/devices/{gatewayId}/topo/query

	消息发送方
	边设备

	消息接收方
	物联网平台


参数说明
	字段名
	必选/可选
	类型
	参数描述

	mid
	必选
	Integer
	命令ID。

	nodeId
	必选
	String
	设备标识。
支持英文大小写，数字和中划线，长度2-64。


示例
	{
	"mid": 2,
	"nodeId": "test123"
}




7查询网关信息响应
主题Topic
	Topic
	/v1/devices/{gatewayId}/queryResponse

	消息发送方
	物联网平台

	消息接收方
	边设备


参数说明
	字段名
	必选/可选
	类型
	参数描述

	mid
	必选
	Integer
	命令ID。

	statusCode
	必选
	Integer
	请求处理的结果码。
“0”表示成功。
非“0”表示失败。

	statusDesc
	可选
	String
	响应状态描述。

	data
	可选
	List<DeviceInfo>
	查询设备信息。

	count
	可选
	String
	设备数量。

	marker
	可选
	String
	标签。



	表1 DeviceInfo结构体说明

	字段名
	必选/可选
	类型
	参数描述

	deviceId
	必选
	String
	平台生成的设备唯一标识，对应设备客户端ID。

	nodeId
	必选
	String
	设备标识。
支持英文大小写，数字和中划线，长度2-64。

	name
	必选
	String
	设备名称。
支持中英文大小写，数字，中划线和#，长度2-64。

	description
	可选
	String
	设备描述。
描述长度不能超过200。

	manufactureId
	必选
	String
	厂商ID。
支持英文大小写，数字，中划线和下划线，长度2-50。

	model
	必选
	String
	产品型号。
支持英文大小写，数字，中划线和下划线，长度2-50。


示例
	{
	"mid": 2,
	"statusCode": 0,
	"statusDesc": "",
        "marker": "",
        "count": "1",
	"data": [
		{
			"deviceId": "D59eGSxy",
			"nodeId": "test123",
			"name": "n-device",
			"description": "addsSubDevice",
			"manufacturerId": "Test_n",
			"model": "A_n"
		}
	]
}



8设备命令下发
主题Topic：
	Topic
	/v1/devices/{gatewayId}/command

	消息发送方
	物联网平台

	消息接收方
	边设备



参数说明
	字段名
	必选/可选
	类型
	参数描述

	deviceId
	必选
	String
	平台生成的设备唯一标识，对应设备客户端ID。

	msgType
	必选
	String
	固定值"cloudReq"，表示平台下发的请求。

	serviceId
	必选
	String
	服务ID。

	cmd
	必选
	String
	服务的命令名。

	paras
	必选
	ObjectNode
	命令的参数。

	mid
	必选
	Int
	命令ID。


示例

	{
         "msgType": "cloudReq",
         "mid": 54132,
         "cmd": "command1",
         "paras": {
                   "temperature": 123
         },
         "serviceId": "service1",
         "deviceId": "D23pigXo"
}




9设备命令下发响应
主题Topic
	Topic
	/v1/devices/{gatewayId}/commandResponse

	消息发送方
	边设备

	消息接收方
	物联网平台


参数说明
	字段名
	必选/可选
	类型
	参数描述

	msgType
	必选
	String
	固定值"deviceRsp"，表示设备的应答消息。

	mid
	必选
	Int
	命令ID。

	errcode
	必选
	Int
	请求处理的结果码。
“0”表示成功。
非“0”表示失败。

	body
	可选
	ObjectNode
	命令的应答。


示例
	{
         "body": {
                   "orginParameters": {
                            "temperature": 123
                   },
                   "state": "ok"
         },
         "errcode": 0,
         "mid": 54132,
         "msgType": "deviceRsp"
}




10设备数据上报
主题Topic
	Topic
	/v1/devices/{gatewayId}/datas

	消息发送方
	边设备

	消息接收方
	物联网平台



参数说明
	字段名
	必选/可选
	类型
	参数描述

	devices
	必选
	DeviceS[]
	设备数据。


DeviceS结构体说明
	字段名
	必选/可选
	类型
	参数描述

	deviceId
	必选
	String(256)
	平台生成的设备唯一标识，对应设备客户端ID。

	services
	必选
	List<Services>
	服务列表。


Services结构体说明
	字段名
	必选/可选
	类型
	参数描述

	serviceId
	必选
	String(256)
	服务ID。

	data
	必选
	ObjectNode
	服务数据。

	eventTime
	必选
	String(256)
	时间格式：yyyyMMdd’T’HHmmss’Z’ 如： 20151212T121212Z。


示例
	{
       "devices": [{
              "deviceId": "D68NZxB4",
              "services": [{
                     "data": {
                            "key": "value"
                     },
                     "eventTime": "20191023T173625Z",
                     "serviceId": "serviceName"
              }]
       }]
}




二、LINK SDK南向开发（Java）
提供物联管理平台提供JAVA语言的接口调用样例进行指导，帮助开发者理解Agent SDK的开发过程，体验设备上线和消息收发等功能。
IOT Agent SDK是LINK提供给设备厂商的二次开发接口，设备厂商使用该SDK对设备进行二次开发后，可以将厂商设备接入到LINK平台，由LINK进行统一管理。
本文档以Agent Java Demo为例，指导开发者使用Agent SDK中的接口。
开发者可以基于Demo开发Agent SDK(Java)，也可参考Demo，自行集成Agent SDK(Java)。
Agent Demo使用的IDE工具为Eclipse，仅适用于Windows系统环境。
LINK最大报文限制为512KB（某些局点因为安全网关的限制，不能超过60K），请在实际的应用开发中做好限制。
1直连设备开发
· 启动Eclipse程序。
· 导入Demo工程。
· [bookmark: ZH-CN_TOPIC_0200316201__li253457173515][bookmark: li253457173515]在菜单栏中依次选择“File > Import > General > Existing Projects into Workspace”，单击“Next”，导入本地Demo工程。如图1所示。
[bookmark: ZH-CN_TOPIC_0200316201__fig162718201238][bookmark: fig162718201238][image: ]
· 单击“Finish”。
· 将已下载的SDK软件包“eip-mqtt-*_spes-iotagent.tar.gz > mqtt-agent-common > lib”目录下的jar包复制到SdkDemo的lib目录下，单击右键选择“Build Path > Add to Build Path”。
[image: ]
· 编写SDK代码，修改文件说明如下表。具体SDK参见Agent SDK接口（Java）下载。 
[image: ]
· 
SDK附件：
2网关设备开发
· 启动Eclipse程序。
· 导入Demo工程。
· 在菜单栏中依次选择“File > Import > General > Existing Projects into Workspace”，单击“Next”，导入本地Demo工程。
[image: ]
· 单击“Finish”。
· 将已下载的SDK软件包“eip-mqtt-*_spes-iotagent.tar.gz > mqtt-agent-common > lib”目录下的jar包复制到GatewaySdkDemo的lib目录下，单击右键选择“Build Path > Add to Build Path”。
[image: ]
· 编写SDK代码，修改文件说明如下表。具体SDK参见Agent SDK接口（Java）下载。 
[image: ]
· 
SDK附件：
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SdkDemo.zip


SdkDemo/.project

 
	 SdkDemo
	 
	 
	
	 
		 
			 org.eclipse.jdt.core.javabuilder
			 
			
		
	
	 
		 org.eclipse.jdt.core.javanature
	







SdkDemo/.settings/org.eclipse.jdt.core.prefs

eclipse.preferences.version=1

org.eclipse.jdt.core.compiler.codegen.inlineJsrBytecode=enabled

org.eclipse.jdt.core.compiler.codegen.targetPlatform=1.8

org.eclipse.jdt.core.compiler.codegen.unusedLocal=preserve

org.eclipse.jdt.core.compiler.compliance=1.8

org.eclipse.jdt.core.compiler.debug.lineNumber=generate

org.eclipse.jdt.core.compiler.debug.localVariable=generate

org.eclipse.jdt.core.compiler.debug.sourceFile=generate

org.eclipse.jdt.core.compiler.problem.assertIdentifier=error

org.eclipse.jdt.core.compiler.problem.enumIdentifier=error

org.eclipse.jdt.core.compiler.source=1.8








SdkDemo/bin/com/huawei/romalink/stub/TerminalStub.class

package com.huawei.romalink.stub;
public synchronized class TerminalStub implements com.huawei.romalink.agent.bridge.IDeviceBridge {
    private static final org.slf4j.Logger logger;
    private com.huawei.romalink.agent.config.AgentConfig config;
    private com.huawei.romalink.agent.bridge.IBridgeContext context;
    private java.util.concurrent.ScheduledExecutorService schduler;
    private java.util.Random random;
    private java.text.SimpleDateFormat dateFormater;
    static void <clinit>();
    public void TerminalStub();
    public void init(com.huawei.romalink.agent.config.AgentConfig, com.huawei.romalink.agent.bridge.IBridgeContext);
    public String bridgeType();
    public void start();
    public void stop();
    public void onDeviceCommand(com.huawei.romalink.agent.domain.DeviceInfo, String, String, com.alibaba.fastjson.JSONObject, com.huawei.romalink.agent.bridge.ServiceCallback);
    public void onDeviceDelete(com.huawei.romalink.agent.domain.DeviceInfo);
}







SdkDemo/bin/iotagent.properties



connectorHost=10.162.21.149

connectorPort=1883

gatewayId=D61641rpX

connectorUser=63B65310A2FA46F7B5223229E2C239D2

connectorPassword=4049633648aaaaaaaaaa

isGatewayDevice=false



deviceIdentifier=SN-40-49-633648

backupFolder=/root/mqtt-agent-ar502/backup



#是否使用ssl加密端口

sslEnable = true

#ssl版本号，该配置项仅当sslEnable为true时有效

sslVersion = TLSv1.2

#ssl端口号，该配置项仅当sslEnable为true时有效

sslPort=8443






SdkDemo/bin/logback.xml

 
	 
		 /root/mqtt-agent-ar502/logs/mqttagent.log
		 
			 /root/mqtt-agent-ar502/logs/mqttagent.%i.log
			 1
			 5
		
		 
			 5MB
		
		 
			 %d{yyyy-MM-dd HH:mm:ss.SSS} %p [%t] %C{0} %M - %m%n
			 UTF-8
		
	

     
         
             %d{yyyy-MM-dd HH:mm:ss.SSS} [%t] [%-5p] [%c.%M %L] %m%n
             UTF-8
        
    

     
         

         
         
    







SdkDemo/bin/META-INF/services/com.huawei.romalink.agent.bridge.IDeviceBridge

com.huawei.romalink.stub.TerminalStub






SdkDemo/src/main/java/com/huawei/romalink/stub/TerminalStub.java



    
    
    SdkDemo/src/main/java/com/huawei/romalink/stub/TerminalStub.java
    
    


SdkDemo/src/main/java/com/huawei/romalink/stub/TerminalStub.javapackage com.huawei.romalink.stub;

import java.text.SimpleDateFormat;
import java.util.Date;
import java.util.Random;
import java.util.concurrent.Executors;
import java.util.concurrent.ScheduledExecutorService;
import java.util.concurrent.TimeUnit;

import org.slf4j.Logger;
import org.slf4j.LoggerFactory;

import com.alibaba.fastjson.JSONObject;
import com.huawei.romalink.agent.bridge.IBridgeContext;
import com.huawei.romalink.agent.bridge.IDeviceBridge;
import com.huawei.romalink.agent.bridge.ServiceCallback;
import com.huawei.romalink.agent.config.AgentConfig;
import com.huawei.romalink.agent.domain.DeviceInfo;
import com.huawei.romalink.agent.domain.response.DeviceCommandResponse;
import com.huawei.romalink.agent.domain.response.ResponseResult;

public class TerminalStub implements IDeviceBridge
{
    private static final Logger logger = LoggerFactory.getLogger(TerminalStub.class);
    
    private AgentConfig config;
    
    private IBridgeContext context;
    
    private ScheduledExecutorService schduler = Executors.newScheduledThreadPool(1);
    
    private Random random = new Random();
    
    private SimpleDateFormat dateFormater = new SimpleDateFormat("yyyy-MM-dd HH:mm:ss");

    @Override
    public void init(AgentConfig config, IBridgeContext context)
    {
        // TODO Auto-generated method stub
        this.config = config;
        this.context = context;
    }

    @Override
    public String bridgeType()
    {
        // TODO Auto-generated method stub
        return "test-terminal";
    }

    @Override
    public void start()
    {
        // TODO Auto-generated method stub
        schduler.scheduleAtFixedRate(() -> {
            JSONObject report = new JSONObject();
            report.put("random", random.nextInt());
            report.put("reportTime", dateFormater.format(new Date()));
            context.selfPropertyReport("testService", report);
        }, 1, 10, TimeUnit.SECONDS);
    }

    @Override
    public void stop()
    {
        // TODO Auto-generated method stub

    }

    @Override
    public void onDeviceCommand(DeviceInfo device, String serviceId, String cmdName,
            JSONObject cmdProperties, ServiceCallback<DeviceCommandResponse> callback)
    {
        // TODO Auto-generated method stub
        logger.info("Received command, serviceId:{}, cmdName:{}, cmdProperties:{}", serviceId,  cmdName, 
                cmdProperties.toJSONString());
        JSONObject result = new JSONObject();
        result.put("requestParam", cmdProperties);
        result.put("state", "ok");
        result.put("time", System.currentTimeMillis());
        
        DeviceCommandResponse resp = new DeviceCommandResponse();
        resp.setDeviceId(config.getGatewayId());
        resp.setResult(ResponseResult.success);
        resp.setMessage("Cmd success");
        resp.setCmdResponse(result);
        
        callback.onResponse(resp);
    }

    @Override
    public void onDeviceDelete(DeviceInfo device)
    {
        // TODO Auto-generated method stub

    }

}






SdkDemo/src/main/resources/iotagent.properties



connectorHost=10.10.10.1

connectorPort=8443

gatewayId=D1040TVfbd 

connectorUser=63B65310A2FA46F7B5223229E2C239D2

connectorPassword=4049633648aaaaaaaaaa

deviceIdentifier=SN-40-15-b156d2

isGatewayDevice=false



backupFolder=/root/mqtt-agent-ar502/backup



#是否使用ssl加密端口

sslEnable = true

#ssl版本号，该配置项仅当sslEnable为true时有效

sslVersion = TLSv1.2

#ssl端口号，该配置项仅当sslEnable为true时有效

sslPort=8443








SdkDemo/src/main/resources/logback.xml

 
	 
		 /root/mqtt-agent-ar502/logs/mqttagent.log
		 
			 /root/mqtt-agent-ar502/logs/mqttagent.%i.log
			 1
			 5
		
		 
			 5MB
		
		 
			 %d{yyyy-MM-dd HH:mm:ss.SSS} %p [%t] %C{0} %M - %m%n
			 UTF-8
		
	

     
         
             %d{yyyy-MM-dd HH:mm:ss.SSS} [%t] [%-5p] [%c.%M %L] %m%n
             UTF-8
        
    

     
         

         
         
    







SdkDemo/src/main/resources/META-INF/services/com.huawei.romalink.agent.bridge.IDeviceBridge

com.huawei.romalink.stub.TerminalStub
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GatewaySdkDemo.zip


GatewaySdkDemo/.project

 
	 GatewaySdkDemo
	 
	 
	
	 
		 
			 org.eclipse.jdt.core.javabuilder
			 
			
		
	
	 
		 org.eclipse.jdt.core.javanature
	







GatewaySdkDemo/bin/com/huawei/romalink/stub/GatewayStub.class

package com.huawei.romalink.stub;
public synchronized class GatewayStub implements com.huawei.romalink.agent.bridge.IDeviceBridge {
    private static final org.slf4j.Logger LOG;
    private com.huawei.romalink.agent.bridge.IBridgeContext context;
    private java.util.concurrent.ScheduledExecutorService schduler;
    private java.util.Random random;
    private java.text.SimpleDateFormat dateFormater;
    static void <clinit>();
    public void GatewayStub();
    public String bridgeType();
    public void init(com.huawei.romalink.agent.config.AgentConfig, com.huawei.romalink.agent.bridge.IBridgeContext);
    public void onDeviceCommand(com.huawei.romalink.agent.domain.DeviceInfo, String, String, com.alibaba.fastjson.JSONObject, com.huawei.romalink.agent.bridge.ServiceCallback);
    public void onDeviceDelete(com.huawei.romalink.agent.domain.DeviceInfo);
    public void start();
    public void stop();
}







GatewaySdkDemo/bin/iotagent.properties



connectorHost=10.162.21.149

connectorPort=1883

gatewayId=SN-40-50-832a75

connectorUser=4AFBA35246914A66AF2BEFE829CDB3EF

connectorPassword=4050832a75aaaaaaaaaa

handlerThreadsNum=4



backupFolder=/root/mqtt-agent-ar502/backup



topicUseIdentifier=true






GatewaySdkDemo/bin/logback.xml

 
	 
		 /root/mqtt-agent-ar502/logs/mqttagent.log
		 
			 /root/mqtt-agent-ar502/logs/mqttagent.%i.log
			 1
			 5
		
		 
			 5MB
		
		 
			 %d{yyyy-MM-dd HH:mm:ss.SSS} %p [%t] %C{0} %M - %m%n
			 UTF-8
		
	

     
         
             %d{yyyy-MM-dd HH:mm:ss.SSS} [%t] [%-5p] [%c.%M %L] %m%n
             UTF-8
        
    

     
         

         
         
    







GatewaySdkDemo/bin/META-INF/services/com.huawei.romalink.agent.bridge.IDeviceBridge

com.huawei.romalink.stub.GatewayStub






GatewaySdkDemo/src/main/java/com/huawei/romalink/stub/GatewayStub.java



    
    
    GatewaySdkDemo/src/main/java/com/huawei/romalink/stub/GatewayStub.java
    
    


GatewaySdkDemo/src/main/java/com/huawei/romalink/stub/GatewayStub.java/*
 * Copyright (c) Huawei Technologies Co., Ltd. 2019-2019. All rights reserved.
 */

package com.huawei.romalink.stub;

import com.huawei.romalink.agent.bridge.IBridgeContext;
import com.huawei.romalink.agent.bridge.IDeviceBridge;
import com.huawei.romalink.agent.bridge.ServiceCallback;
import com.huawei.romalink.agent.config.AgentConfig;
import com.huawei.romalink.agent.domain.DeviceConnStatus;
import com.huawei.romalink.agent.domain.DeviceInfo;
import com.huawei.romalink.agent.domain.DeviceStatus;
import com.huawei.romalink.agent.domain.response.DeviceCommandResponse;
import com.huawei.romalink.agent.domain.response.ResponseResult;

import com.alibaba.fastjson.JSONObject;

import org.slf4j.Logger;
import org.slf4j.LoggerFactory;

import java.text.SimpleDateFormat;
import java.util.Date;
import java.util.Random;
import java.util.concurrent.Executors;
import java.util.concurrent.ScheduledExecutorService;
import java.util.concurrent.TimeUnit;

/**
 * 〈功能描述〉
 *
 * @author q00240664
 * @since 2019-10-19
 */
public class GatewayStub implements IDeviceBridge {
    private static final Logger LOG = LoggerFactory.getLogger(GatewayStub.class);

    private IBridgeContext context;

    private ScheduledExecutorService schduler = Executors.newScheduledThreadPool(1);

    private Random random = new Random();

    private SimpleDateFormat dateFormater = new SimpleDateFormat("yyyy-MM-dd HH:mm:ss");

    @Override
    public String bridgeType() {
        // TODO Auto-generated method stub
        return "gatewayStub";
    }

    @Override
    public void init(AgentConfig config, IBridgeContext context) {
        this.context = context;
    }

    @Override
    public void onDeviceCommand(DeviceInfo device, String serviceId, String cmdName, JSONObject cmdProperties,
        ServiceCallback<DeviceCommandResponse> callback) {
        // TODO Auto-generated method stub
        LOG.info("Received command, serviceId:{}, cmdName:{}, cmdProperties:{}", serviceId, cmdName,
            cmdProperties.toJSONString());
        JSONObject result = new JSONObject();
        result.put("requestParam", cmdProperties);
        result.put("state", "ok");
        result.put("time", System.currentTimeMillis());

        DeviceCommandResponse resp = new DeviceCommandResponse();
        resp.setDeviceIdentifier(device.getDeviceIdentifier());
        resp.setResult(ResponseResult.success);
        resp.setMessage("Cmd success");
        resp.setCmdResponse(result);

        callback.onResponse(resp);
    }

    @Override
    public void onDeviceDelete(DeviceInfo info) {
        // TODO Auto-generated method stub

    }

    @Override
    public void start() {
        // TODO Auto-generated method stub
        DeviceInfo childDevice = new DeviceInfo(null, "aaa", "aaa", "aaa", "aaa");
        childDevice.setDeviceIdentifier("sdkChild");
        context.registerDevice(childDevice, resp -> {
            if (resp.getResult() == ResponseResult.fail) {
                LOG.error("Failed to register device:{}", resp.getMessage());
                return;
            }
            DeviceStatus deviceStatus = new DeviceStatus();
            deviceStatus.setDeviceIdentifier("sdkChild");
            deviceStatus.setConnectStatus(DeviceConnStatus.online);
            context.changeDeviceConnectStatus(deviceStatus, onlineResp -> {
                if (onlineResp.getResult() == ResponseResult.fail) {
                    LOG.error("Failed to change device state:{}", resp.getMessage());
                    return;
                }

                schduler.scheduleAtFixedRate(() -> {
                    JSONObject report = new JSONObject();
                    report.put("random", random.nextInt());
                    report.put("reportTime", dateFormater.format(new Date()));
                    context.propertyReport(childDevice, "testService", report);
                }, 1, 10, TimeUnit.SECONDS);
            });
        });
    }

    @Override
    public void stop() {
        // TODO Auto-generated method stub

    }
}






GatewaySdkDemo/src/main/resources/iotagent.properties

connectorHost=10.10.10.1

connectorPort=8443

gatewayId=SN-40-7-59b7f2 

connectorPassword=4050832a75aaaaaaaaaa

clientId=D1040TVfbd



handlerThreadsNum=4



backupFolder=/root/mqtt-agent-ar502/backup



topicUseIdentifier=true



#是否使用ssl加密端口

sslEnable = true

#ssl版本号，该配置项仅当sslEnable为true时有效

sslVersion = TLSv1.2

#ssl端口号，该配置项仅当sslEnable为true时有效

sslPort=8443






GatewaySdkDemo/src/main/resources/logback.xml

 
	 
		 /root/mqtt-agent-ar502/logs/mqttagent.log
		 
			 /root/mqtt-agent-ar502/logs/mqttagent.%i.log
			 1
			 5
		
		 
			 5MB
		
		 
			 %d{yyyy-MM-dd HH:mm:ss.SSS} %p [%t] %C{0} %M - %m%n
			 UTF-8
		
	

     
         
             %d{yyyy-MM-dd HH:mm:ss.SSS} [%t] [%-5p] [%c.%M %L] %m%n
             UTF-8
        
    

     
         

         
         
    







GatewaySdkDemo/src/main/resources/META-INF/services/com.huawei.romalink.agent.bridge.IDeviceBridge

com.huawei.romalink.stub.GatewayStub
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